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Safety Precautions 

Electric Shock Warning 

This equipment may cause electric shocks if not handled properly. 
 Access to this equipment should only be granted to trained operators 

and maintenance personnel who have been instructed of, and fully 
understand the possible hazardous conditions and the consequences of 
accessing non-field-serviceable units such as the power supplies. 

 The system must be unplugged before moving, or in the even that it 
becomes damaged.  

 

 Reliable Grounding 

Particular attention should be given to prepare reliable grounding for the 
power supply connection. It is suggested to use a direct connection to the 
branch circuit. Check for proper grounding before powering on the device. 
 

Overloading Protection 

The device should be installed according to specifications. Provide a suitable 
power source with electrical overload protection. Do not overload the AC 
supply branch circuit that provides power to the device.  
 

ESD Precautions 

Please observe all conventional anti-ESD methods while handling the device. 
The use of a grounded wrist strap and an anti-static work pad are 
recommended. Avoid dust and debris in your work area. 
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Device Installation/Site Selection 
The device should be installed according to specifications. This device 

should be operated at a site that is:  

 Clean, dry, and free of excessive airborne particles.  

 Well-ventilated and away from heat sources such as direct sunlight 

and radiators.  

 Clear of vibration or physical shock.  

 Away from strong electromagnetic fields produced by other devices.  

 Available with properly grounded wall outlet for power. In regions 

where power sources are unstable, apply surge suppression.  

 Available with sufficient space behind the device for cabling.  

Never install or use, unless waterproof or dust-resistant is listed as a 

feature, the device in the following locations: 

 Areas where chemicals are used. 

 Areas where dust, debris, or pollen is in excess. 

 Areas where corrosive gas, sea water or high humidity is present. 

 Areas where steam vapor or flammable environments is generated.  

 Areas where radiation, X-rays, strong electric waves, or magnetism is 

generated. 

 Areas outside of the allowable ambient operating temperature range.  

 Areas subject to impact or rigorous vibration. 
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Chapter 1. Product Overview 

1.1. Network Camera Introduction 
CAM5XXX series are professional network cameras that use Internet Protocol (IP) to 

transmit video streams and control signals over networks. Capable of operating 

over both LANs and WANs, they provide a complete budget-conscious remote 

surveillance solution that are ultra clear and highly integrated. CAM5XXX series 

combine a user-friendly interface and simplified installation with a powerful 

feature set to provide users an easy upgrade path to new digital surveillance 

system in a virtual environment. These highlights make CAM5XXX series ideal 

choices for environments that require remote surveillance or video transmission. 
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1.2. Features and Benefits 
CAM5XXX series IP camera is a cutting-edge digital video transmission device. It 

can compress and transmit real-time images of outstanding quality using a 

reasonable amount of bandwidth through a standard TCP/IP network. The 

following features make this IP camera an outstanding choice when building an 

intelligent IP surveillance system: 

 High Video Quality 

High image quality is essential in security surveillance applications. It is 

important to be able to clearly capture an incident in progress and 

identify persons or objects involved. A network camera gives exceptional 

video quality, even greater than that of traditional analog cameras, which 

means that more detail or larger areas can be covered.  

 

 H.264/MPEG-4/MJPEG Compression 

Motion JPEG, MPEG-4, and H.264 (also known as MPEG-4 Part 10/AVC), 

each employ different techniques to reduce the amount of data 

transferred and stored in a network video system. Network cameras that 

support multiple compression standards are ideal for maximum flexibility 

and integration possibilities. 

 

 Dual Streaming 

Dual-stream design enables simultaneous support of real-time video 

monitoring, video recording, or mobile viewing applications which require 

different resolutions, compression formats and frame rates. 

 

 Tampering Detection 

This is an intelligent video analytics application available only in selected 

network cameras in the market. When a camera is manipulated in any way 

(e.g. accidental redirection, blocking, defocusing, spray-painted, covered 

or damaged), it can automatically trigger recording and alert notifications. 
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 Power-over-Ethernet 

The built-in Power-over-Ethernet support reduces cabling and installation 

costs, and enables users to consolidate power facilities for higher 

reliability. With PoE, a camera can still operate in the event of a power 

failure if it is connected to a centralized backup power with an 

Uninterruptible Power Supply. 
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1.3. Technical Specifications  
Model List for CAM5XXX Series 

CAM5XXX Series 

CAM5330SZ CAM5321S4 

  

2 Megapixel 10x Zoom PTZ Dome 
Network Camera 

2 Megapixel Day&Night PT Dome 
Network Camera 
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Specifications for CAM5XXX Series 

Specifications Model Name CAM5330SZ CAM5321S4 

General 

Description 
2 Megapixel 10x Zoom 

IP PTZ Dome 

2 Megapixel Day&Night  

PT Dome Network Camera 

Image Sensor 
1/2.7” 2 megapixel progressive 

scan CMOS 

1/2.7” 2 megapixel progressive 

scan CMOS 

Lens 
f4.9~ 49mm autofocus lens, 

F1.8~3.0 
f4.0 mm, F2.0 

SNR 48dB 48dB 

WDR Yes Yes 

Day/Night ICR N/A Yes 

IR LED N/A Yes (10M) 

Min 
Illumination 

0.1 Lux @ F2.0 (B/W) 

0.5 Lux @ F2.0 (Color) 

0.1 Lux @ F2.0 (B/W) 

0.5 Lux @ F2.0 (Color) 

Iris Control DC Drive Fixed 

Shutter Time 1/30 ~ 1/50,000 s 1/30 ~ 1/50,000 s 

Viewing Angle Diagonal: 66.6° ~ 7.2° Diagonal: 62° 

Camera Angle 
Adjustment 

Pan : 390°(-195°~195°)±1°, 

Pan speed : 1~200°/Sec 

Tilt : 95°(-5°~ 90°)±1°,  

Tilt speed : 1~120°/Sec 

Pan : 200° 

Tilt : 70° 

Pan/Tilt/Zoom 
Functionalities 

10x optical zoom ,  

4x digital zoom  

(Smart focus / Auto focus / Step 

focus),  

Support auto tracking 

function, Support multi - 

direction movement 

Support auto tracking function, 

Support multi - direction 

movement 

Video Video 
Compression 

H.264/MPEG-4/MJPEG H.264/MPEG-4/MJPEG 
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Resolution Up to 1920 x 1080 Up to 1920 x 1080 

Frame Rate 

30 fps at 1080P (1920 x 1080) 

30 fps at SXGA (1280 x 1024) 

30 fps at WXGA (1280 x 800) 

30 fps at VGA (640 x 480) 

30 fps at QVGA (320 x 240) 

30 fps at 1080P (1920 x 1080) 

30 fps at SXGA (1280 x 1024) 

30 fps at WXGA (1280 x 800) 

30 fps at VGA (640 x 480) 

30 fps at QVGA (320 x 240) 

Video Stream 
Dual stream at H.264 and MJPEG 

simultaneously 

Dual stream at H.264 and 

MJPEG simultaneously 

Bit Rate 64K ~ 10Mbps, VBR, CBR, controller 
frame rate and quality 

64K ~ 10Mbps, VBR, CBR, 
controller frame rate and quality 

Video Control 

AGC (Auto Gain Control),  

AWB (Auto White Balance),  

AES (Auto Electronic Shutter), 

WDR, 3D De-noise, ROI, image 

adjustment 

AGC (Auto Gain Control),  

AWB (Auto White Balance),  

AES (Auto Electronic Shutter), 

WDR, 3D De-noise, ROI, image 

adjustment 

Intellige

nt Video 
Motion detection Motion detection 

Video Jack Video out x1 N/A 

Audio 

Built-in MIC N/A Yes 

Audio 
Compression 

G.711/AMR/AAC G.711/AMR/AAC 

Audio Input 3.5mm phone jack N/A 

Audio Output 3.5mm phone jack N/A 

I/O and Event 
Management 

Alarm In 1, terminal block N/A 

Alarm Out 1, terminal block N/A 

Video Buffer N/A N/A 

Event Action 
Send snapshot or video clip by 

email, record to local storage 

Send snapshot or video clip by 

email, record to local storage 

Network Supported 
Protocols 

TCP/IP, HTTP, SMTP, FTP, DDNS, 

UPnP, Telnet, NTP, PPPoE, DNS, 

DHCP, RTSP, Samba 

TCP/IP, HTTP, SMTP, FTP, 

DDNS, UPnP, Telnet, NTP, 

PPPoE, DNS, DHCP, RTSP, 

Samba 
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Ethernet 10/100 Base-T / RJ45 10/100 Base-T / RJ45 

System 

Local Storage SD Card slot x 1 SD Card slot x 1 

RS-485 N/A N/A 

USB USB 2.0 x 1 USB 2.0 x 1 

SDK Surveon SDK 2.0 Surveon SDK 2.0 

Viewing System 

OS 
Microsoft Windows 

XP/Vista/Win7/Win8 

Microsoft Windows 

XP/Vista/Win7/Win8 

Browser 
IE 6.x or above, Firefox, 

Chrome, Safari 

IE 6.x or above, Firefox, 

Chrome, Safari 

Software Surveon VMS 2.6 Surveon VMS 2.6 

General 

Temperature 
Operation: 

0°C~ 40°C (32°F~104°F) 

Operation:  

0°C~ 40°C (32°F~104°F) 

Humidity 85% RH 85% RH 

Power 
12VDC 1.5A； 

PoE (IEEE 802.3af) with Class 3 

12VDC 1.5A； 

PoE (IEEE 802.3af) with Class 3 

Power 
Consumption 

Max. 10W Max. 8W 

Dimension 
Height : 128mm,  

Diameter : 130mm 

Height : 63mm,  

Diameter : 92mm 

Weight NET. 960g NET. 400g 

Certification EMI & Safety: CE, FCC EMI & Safety: CE, FCC 
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Chapter 2. Hardware Overview 

2.1. Overview  
 
Side View for CAM5330SZ 

 

 
Bottom View for CAM5330SZ 
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Rear View for CAM5330SZ 
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Rear View for CAM5321S4 
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Dimensions 

 
CAM5330SZ 

Unit: mm (inches) 
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CAM5321S4 
Unit: mm (inches) 
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2.2. Functions  
CAM5330SZ 

 

 
CAM5321S4 
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1. DC Power Jack  

The DC power input jack is located on the rear of Network Camera’s. The input 

power is 12VDC. Note that supply the power to the Network Camera with standard 

power adapter included in package. Otherwise, the improper power adapter may 

damage the unit and result in danger.  

 

2. LAN Socket 

Beside the DC power Jack, the LAN socket is an RJ-45 connector for connections to 

10Base-T or 100Base-TX Fast Ethernet cabling. Please use Category 5 “straight 

through” cable to connect the Network Camera to an Ethernet network switch or 

hub. 

 

3. Front LEDs  

Red LED indicates power, red LED will turn on always after plug-in power. 

Green LED indicates networking, green LED will blink every second after getting IP 

address. 

 
Upon powering up, two of front LEDs will become lighted then the camera will do 

self-rotation. During the self-rotation, red LED will be on and the network camera 

is standby for getting IP address. 

 
4. Factory Default Reset 

This button is hidden in the pinhole under then Network Camera’s bottom. Please 

refer to the Appendix A in this manual for more information. 

 

5. SD Card slot and USB socket 

The built-in SD/SDHC card slot offers a convenient and portable storage 

(snapshots and video clips) option to prevent data loss in case of network 

disconnection. 

 

6. Microphone in and A/V out 

The Network Camera supports two way audio communication so that operators 

can transmit and receive audio simultaneously. By using the Network Camera’s 

built-in or external microphone and an external speaker, you can communicate 

with people around the Network Camera. 
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7. General I/O Terminal Black 

This Network Camera provides a general I/O terminal block which is used to 

connect external input / output devices. 
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2.3. Hardware Installation 
CAM5330SZ 
1. Attach the Network Camera with the included stand. 

2. Place the camera on the table or install it onto the ceiling or wall. 

Use screws to secure the camera. 
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CAM5321S4 
1. Attach the Network Camera with the included stand. 

2. Place the camera on the table or install it onto the ceiling or wall. 

Use screws to secure the camera. 

 

 

 

 

 

 



  

 27 

2.4. Wiring 
CAM5330SZ 

1. Plug a RJ-45 Ethernet cable into the Network Camera 
 

Connect an Ethernet cable to the LAN socket located on the rear of Network 
Camera’s and attach it to the network.  

 

 

2. Connect the external power supply to Network Camera 

Connect the attached power adapter to the DC power jack of the Network 
Camera. Note: Use the power adapter, 12VDC, included in the package and 
connect it to wall outlet for AC power.  

 
Once you have installed the Network Camera well and powered on, the 

camera will self-rotate, the red LED will be on, and the green LED will flash 

in every second, meaning the system is booting. 
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3. General I/O Terminal Block 

 

 

 

 

If you have external devices such as sensors and alarms make connection 

from I/O terminal block.  
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CAM5330SZ 
Via a PoE Switch:  

Use a PoE switch to connect the camera for power and network connection.  

 

 

 
Via a PoE Power Injector:  

When your switch does not support PoE, use a PoE power injector (user 

provided item) to connect the camera for power and network connection 
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CAM5321S4 
Via a PoE Switch:  

Use a PoE switch to connect the camera for power and network connection.  

 

 

Via a PoE Power Injector:  

When your switch does not support PoE, use a PoE power injector (user 

provided item) to connect the camera for power and network connection 
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2.5. Camera Deployment 
CAM5330SZ/5321S4 
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2.6.  Minimum System Requirement  
 

Network Environment 

LAN 10/100/1000M Ethernet  

Monitoring System Recommended for Internet Explorer 

System Hardware  Basic requirements 

· CPU: Intel® Celeron® Dual-Core @2.70GHz or above 

· Memory Size: 2 GB or above Recommended  

· VGA card resolution: 1024 x 768 or above  

System Requirement for Viewer & Recorder Application 

Support OS XP, Windows 7 

System Hardware 1-4 cameras surveillance application 

· CPU: Intel® Celeron® Dual-Core @ 2.70GHz or above 

· Memory Size: 2 GB or above 

· VGA card resolution: 1024 x 768 or above  
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Chapter 3. Connecting to the 

Network Camera 
This section demonstrates how to connect to the network camera through two 

methods: 

• Web Browser – A simple web-based interface. Internet Explorer is the 

recommended web browser for use with network cameras, and our 

examples will be from this browser. Usage on other browsers will be 

similar. 

• RTSP Player – These include common streaming media players, such as 

RealPlayer or Quicktime Player. These players can provide live view of 

the camera using the Real-Time Streaming Protocol (RTSP).  
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3.1. Connecting with a Web Browser 
Obtaining IP address through the IP Utility 
The IP address can be obtained using the IP Utility in your product CD: 

1. Double click Start SearchToolInstall.exe to begin the utility installation. 

2. After the installation is complete, click the Auto Search button or click 

Camera > Search in the menus.  

 
The camera search will begin, and a status bar will display the search 

progress. 

    3. The details of the camera will display after the search is finished. 

 
 

Note: (1) The search may take up to 2 minutes, depending on your network 

configuration.  
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Connecting to the Network Camera  
Launch the web browser (Microsoft ® Internet Explorer 6.0 or higher is 

recommended). Enter the IP address of the network camera in the address 

bar of your browser and press enter.  

You can also Click the Link to Camera button or click to Camera> Link to 

Camera in the IP Utility menu bar. The camera’s live view webpage will 

open in a browser window. 

 

 
Logging into the System  

The following information will prompt for logging in: 

                    

 Username – The username for the domain. Default is always admin. 

 Password – The password for the domain. Default is always admin. 

Click OK. 
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Installing ActiveX Components in Internet Explorer 
You may be prompted to install ActiveX® components when accessing the 

network camera’s Live View page; click Yes when prompted. You will be able 

to access the camera after installation is completed. Under Windows, this 

action may require administrator privileges. 

If the dialog box suggests that you are not allowed to install ActiveX 

components, try resolving the problem using the following steps: 

1. In Internet Explorer, open Tools> Internet Options> Security. Click 

the Custom level button.  

2. Search for Download signed ActiveX controls. Under this heading 

select Prompt and then click OK. 

3. Continue installing the Active X components. 

4. After installing ActiveX, go to Tools> Internet Options> Trusted 

Websites> Sites and add the IP Address of the camera. 
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Chapter 4. Configuration through 

the Web Interface 

4.1. Interface Layout 
This section demonstrates the layout of the network camera’s main interface. 

The 6 main areas on the interface are:  

 

CAM5330SZ 2Megapixel 10x Zoom PTZ Dome Network Camera 

 

CAM5321S4 2Megapixel Day & Night PT Dome Network Camera 
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1. Connection Controls – Remote/Local viewing, video stream selection, 

and digital output controls.  

2. Pan/Tilt/Zoom, focus, optical controls – Directional pad for pan and 

tilt functionalities. Controls over zoom, focus, iris, patrol and track.  

3. Button Bar - These controls allow the user to quickly access common 

features such as live view window resizing, video and still frame 

capture, interface language, and audio controls. 

4. Live View Window Size - Live view window resizing to 100%, 50%, and 

25%. 

5. Live View Window - This portion of the screen displays the stream 

selected . 

6. Button Bar - These controls allow the user to quickly access common 

features such as snapshot, digital zoom, full screen, and audio 

controls. 
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Control Descriptions 
Control Description 

 

Snapshot: When clicked, captures the current 

screen as an image in a new pop-up window.  

 
Digital Zoom: Enable digital zoom  

 
Full-Screen: Goes to full-screen when clicked; 

press “ESC” to return to windowed view. 

 

Pause: Pause recording or playing 

 

Stop: Stop recording or playing 

 

Manual Record: When clicked, records the 

current live video. The location for storing the 

video can be changed under Client setting > 

Recording options. 

Note: Due to the UAC (User Access Control) 

function in Windows Vista or Windows 7, the IE 

browser would need to be run under the 

“Administrator” privilege. 

 

Volume: Sets to the current computer volume; 

Dragging the slider adjusts the volume. 

 

Mute: Mutes the audio captured by the camera 

when clicked, un-mutes the audio when 

clicked again. 

 

Talk: Allows audio to be transmitted from a 

local microphone to the camera. Multiple users 

may access the live view page and receive 

audio from the camera. 

 

Mic Volume: Sets to the current computer 

volume; Dragging the slider adjusts the 

volume. 
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Mic Mute: Mutes the audio captured by the 

camera when clicked, un-mutes the audio 

when clicked again. 

 
After Administrator has determined the preset 

positions, users can select the presets here.  

 
User can choose Remote or Local mode for 

best connection quality. 

For Internet environment, switch to Remote 

mode. 

 
Stream 1,2 or serial video pictures can be 

selected.  

 Enable/disable digital output 

 

Use the directional pad to pan and tilt. Click 

the home button to go back to the center. 

 
Control zoom  

 
Control focus 

 
Use this button to have focus adjusted 

automatically  

 
Control Iris 

 
Click this button to move from right to left 

continuously. 

 
Patrol among the preset positions, which can 

be configured on the “Camera control page”. 

The cycle of patrol is from 1 to Unlimited. 

 
Track dynamic objects within screen video 

 
Adjust pan angle 1~1800 

 
Adjust tilt angle 1~550 
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Adjust zoom step 1~3 

 
Adjust focus step 1~7 

 
For settings including internet, intranet and 

recording options 

 
For other detailed settings 

 
Select a language from the list 
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4.2. Client Setting 

 

Protocol Options which allows choices on connection protocol between client 

and server. There are three protocols choices to optimize your usage – UDP, 

TCP, HTTP.  

 

The UDP protocol allows for more real-time audio and video streams. 

However, some packets may be lost due to network burst traffic and images 

may be obscured.  

 

The HTTP protocol allows for less packet loss and produces a more accurate 

video display. The downside with this protocol is that the real-time effect is 

worse than that with the UDP protocol. 

 

The TCP guarantees the complete delivery of streaming data and thus 

provides better video quality. However, the real-time effect is not as good as 

that of the UDP protocol. 
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If no special need is required, UDP protocol is recommended. Generally 

speaking, the client choice will be in the order of UDP → HTTP.  After the 

Network Camera is connected successfully, “Protocol Option” will indicate 

the selected protocol. The selected protocol will be recorded in the user's PC 

and will be used for the next connection. If the network environment is 

changed, or the user wants to let the web browser to detect again, manually 

select the UDP and TCP protocol, save, and return HOME to re-connect. 

 

Internet Settings 

 UDP 
 TCP 
 HTTP 

 
 

Intranet Settings 

 UDP 
 TCP 
 HTTP 
 
 

Recording Options 

Users can record live video as they are watching by clicking  to record in MP4  
format. Here, you can specify the storage destination and file name. 
 Folder: use browse to specify the storage destination for the recorded 

video files. 

 File name prefix: Enter the text that will be appended to the front of 

the video file name. 

 Add date and time suffix to file name: Select this option to append the 

date and time to the end of the file name. 
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4.3. Configuration 
Click Setup for configuration. 

Remember to click Finish to save the settings.  

 

Home 

Click this option to go back to the live view page. 

 

System 
(DI and DO setting is for CAM5330SZ only.) 
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General Setting 

 

 Host name: The text displays the title on the top of the main page.  

 LED indicator: Select turn on or turn off the led indicator. 

 

Time Setting 

 

 Time Zone: Select time zone from the dropdown list.  

 Daylight saving time: Select turn on or turn off the led indicator. 

 Current time 

 Keep Current time 

 Sync with PC - Synchronizes the time with the computer’s internal 

clock. 

 Manually set the time- Updates the time manually. Choose the 

appropriate date and enter a time for the system. 
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 Adjust by NTP server - NTP is a protocol for synchronizing the 

system clock to an external server. If this option is chosen, enter 

the IP address of a known NTP server in the NTP Server field. 

 

DI and DO Setting  

(DI and DO setting is for CAM5330SZ only.) 

 

Digital Input (DI) and Digital Output (DO) stand are used for event triggering. 

Select Open or Ground to define the DO active state. 
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User Management 

The administrator account name is “root”, which is permanent and cannot 

be deleted. If you want to add more accounts in the Manage User column, 

please set a password for the “root” account first. Network Camera can 

provide twenty accounts for your valuable customers or friends. 

 

 Change root password - Change the Administrator’s password by typing 

in the new password identically in both text boxes. The typed entries 

will be displayed as asterisks for security purposes. After pressing 

“finish”, the web browser will ask the Administrator for the new 

password to access. 

 

 Manage privilege - You can modify the manage privilege of operators or 

viewers. Check or uncheck the item, then click finish to enable the 

settings. 

 

 Manage user 

 Add a new user - Administrators can add up to 20 user accounts. 

(A) Input the new user’s name and password. 

(B) Select the privilege level for the new user account. Click Finish to 

enable the setting. 

 Delete a user - Select an existing user name. Click Finish to enable 

the setting. 
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 Update an existing user - Select an existing user name. 

Administrators can modify user’s password and privilege. Click 

Finish to enable the setting. 

 

Access rights are sorted by user privilege (Administrator, Operator, and 

Viewer). Only administrators can access the Configuration page. Operators 

cannot access the Configuration page but can use the URL Commands to get 

and set the value of parameters. Viewers access only the main page for live 

viewing. 
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Network  

 
 

Network setting 

 

The default type is LAN. Select PPPoE when using ADSL 
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 LAN  

 Get IP address automatically 

The default status is Get IP address automatically. It could be tedious 

to perform software installation whenever the Network Camera starts. 

Therefore, once the network is set, the IP address should be entered 

correctly. 

 Use fixed IP address 

Select Use fixed IP address, the Network Camera will skip installation. 

The Network Camera will automatically restart and operate normally 

after a power outage. You can run IP installer to check the IP address 

assigned to the Network Camera if the IP address is forgotten, or you 

can use the UPnP function provided by the Network Camera (MS 

Windows XP provides UPnP function at My Network Place).   

 

 IP address: This is necessary for network identification.  

 Subnet mask: This is used to determine if the destination is in 

the same subnet. The default value is “255.255.255.0”.  

 Default router: This is a gateway used to forward frames to 

destinations in a different subnet. Invalid router setting will fail 

the transmission to destinations in different subnet.  

 Primary DNS: The primary domain name server that translates 

hostnames into IP addresses.  

 Secondary DNS: Secondary domain name server backups the 

Primary DNS.  

 Enable UPnP presentation & port forwarding: Enable UPnP 

ability.  

 Http port: This can be typed besides the default Port 80. Once 

the port is changed, the users must make sure the change for the 

connection is successful. For instance, when the Administrator 

changes the HTTP port of the Network Camera which IP address is 

192.168.0.20 from 80 or 1025 to 65535, the users must type in the 

web browser “http://192.168.0.20:8080” instead of 

“http://192.168.0.20”. 

 RTSP Port RTSP port can be typed besides the default Port 554 
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 RTP Port The RTP port can be typed besides the default Port 54 

Note: Please set Video RTP port in even number after default value port 54. 

Then, Video RTCP pot, Audio RTP port, Audio RTCP port will 

automatically set the values in ascending. 

 RTSP Streaming access names: The RTSP streaming currently 

supports video only, audio only, and audio/video. To use the 

audio/video stream, type the URL 

as“rtsp://61.30.125.43/liveN.sdp”. 

 

 PPPoE  

If using the PPPoE interface, you should fill the following settings from ISP.  

 Account: The login name of PPPoE account  

 Password: The password of PPPoE account  

 Confirm password: Input password again for confirmation 

 

DDNS setting 
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 Enable DDNS: This option turns on the DDNS function. 

 ip-discovery: In the Register column, fill in the Host name (xxxx. ip-

discovery), Email, Key, and Confirm Key, then click Register. After a host 

name has been successfully created, a success message will be displayed in 

the DDNS Registration Result column and messaging E-mail.  

 3rd party DDNS: This is enable or disable 3rd party DDNS. 

 Provider: The provider list contains hosts that provide DDNS services. 

Please connect to the service provider’s website to make sure the service 

charges. 

 Host Name: If the User wants to use DDNS service, this field must be filled. 

Please input the hostname that is registered in the DDNS server. 

 User name: The Username or E-mail field is necessary for logging in the 

DDNS server or notify the User of the new IP address.  

 

Note: when this field is input as “User name”, the following field must be 

input as “Password”. 

 

 Password: Please input the password or key to get the DDNS service. 

 finish: Click on this button to save modify settings for the DDNS service. 
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Access List 
 
Control access permission by verifying the client PC’s IP address. 

 
 
Click Add an address to add a rule to Allowed/Denied list.  
 
There are three types of rules for user to set up: 
 Single: This rule allows the user to add an IP address to the 

Allowed/Denied list. 

 Network: This rule allows the user to assign a network address and 

corresponding subnet mask to the Allow/Deny List. The IP address is 

written in the CIDR format. 

 Range: This rule allows the user to assign a range of IP addresses to the 

Allow/Deny List. This rule is only applied to IPv4. 
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Audio and Video 
General Setting 

 
 Color mode: Select use color or monochrome video display. 

 Video orientation: The orientation of video 

 Flip: Vertically rotate the video.  

 Mirror: Horizontally rotates the video.  

 Environment: The orientation of video 

 Indoor: This option is usually selected when the Network Camera is 

placed in indoor environments. 

 Outdoor: This option is usually selected when the Network Camera is 

placed in outdoor environments. 

 Power freq.: Select 50 Hz or 60Hz power line frequency. 

※The fluorescent light will flash according to the power line frequency that 

depends on local utility. Change the frequency setting to eliminate 

uncomfortable flash image when the light source is only fluorescent light. 
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Video Setting 

 
 Brightness: Adjust the image brightness level, which ranges from -5 to 

+5. The default value is set to 0. 

 Saturation: Adjust the image saturation level, which ranges from -5 to 

+5. The default value is set to 0. 

 Contrast: Adjust the image contrast level, which ranges from -5 to +5. 

The default value is set to 0. 

 Sharpness: Adjust the image sharpness level, which ranges from -5 to +5. 

The default value is set to 0. 

 EV: Exposure value represents the expected target value of the 

luminance of the weighting result of AE windows in the image and its 

tolerance as offset. 

 Gain: In the slide bar of Gain, there are also two sliders, which represent 

the limitations to control the maximum gain value and the minimum one, 

respectively. Normally, the minimum value is to 1x for better quality. 
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Exposure Setting 

Here it provides 3 modes:  

 Auto 

 Backlight 

 Customized 

Auto and Backlight modes are 2 default settings for general purpose and 

backlight scene, respectively. 

 

Customized mode relates to the grid window above can be pointed on for 

interesting areas. Within the mode Customized, 16*15 grids windows can be 

chosen to match where/what you are interested in. Push down left-button of 

mouse and drag to draw the grids for interesting areas, or push down right-

button of mouse and drag to clean the grids for insignificant areas. 
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 Target Luminance and Offset 

These two slide bar, Target Luminance and Offset represent the 

expected target value of the luminance of the weighting result of AE 

windows in the image and its tolerance as offset. For example, target 

luminance is set to 100 and target offset is set to 20 that means the 

average luminance of the AE window should be in the range from 80 to 

120 (100±(10. When the actual luminance does not meet this range, the 

AE function will adjust shutter and gain to meet it as possible. In some 

extreme cases, it cannot reach the target because the environment is 

too bright or dark. When the environment is not consistent, e.g. with big 
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moving objects, and the offset is too narrow, the AE will act more 

frequently that will cause the background of view inconsistent. The 

offset value is recommended to set 15~25% of target luminance. 

 

 Gain 

In the slide bar of Gain, there are also two sliders, which represent the 

limitations to control the maximum gain value and the minimum one, 

respectively. Normally, the minimum value is to 1x for better quality. It 

is not allowed if the maximum slider and the minimum one are set to the 

same value without adjustable interval. Besides, the noise will be 

increased if the actual gain is too large. When the max. slider is dragged 

over sensor's max. gain, the slide bar will become deep blue to represent 

it will apply Mozart 3s digital gain, which extend the max. gain for very 

low light. 

 

 Shutter Speed 

There are 2 fields, minimal and maximal time, for the range of Shutter 

Speed. The precision of the parameter is 1/1000000 sec., but it is NOT 

actual precision of the shutter speed of the sensor. The actual precision 

of the shutter speed depends on each sensor’s specification. Here it will 

be rounded to approach sensor’s effective exposure time. To avoid 

flickering or banding phenomenon under fluorescent light, the actual 

shutter speed will be locked at 1/120, 1/60, 1/30 if Power Line 

Frequency is 60Hz, or 1/100, 1/50, 1/25 if Power Line Frequency is 50Hz. 

The setting of Power Line Frequency is on the sub-tab Video and Audio. 

The exposure may not be stable if the maximum value and the minimum 

one are set to the same value without adjustable interval. Besides, the 

frame rate will drop down if the actual shutter speed is too slow to meet 

expected frame rate. 
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Noise reduction 

Here provides 2D and 3D features, reducing noises in low light conditions and 

even with moving objects. 

 

 

Wide Dynamic Range 

Enable Wide Dynamic Range to improve the exposure, when both bright and 

dark areas are in the field of view of the camera at the same time. The 

default is off. 

 

Low Lux Setting  

(Low Lux setting is for CAM5330SZ only.) 
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Turn on this functionality to have the video quality improved, when the 

camera is in the low lux environment. 

 Disable dark mode: Disable low lux mode. 
 Enable dark mode: Enable low lux mode. 

 

Video output Setting 

(Video Output setting is for CAM5330SZ only.) 

 NTSC  

 PAL 

 

 

Infrared LED Setting 

(Infrared LED setting is for CAM5321S4 only) 

 

 Infrared LED Control: IR LED for Day and Night (Optional). Users can 

turn on/off the built-in IR LED. This function is very useful under low 

illumination environment. 

 Auto: Select IR sensitivity from 0 to 4. 

 Manual: Turn on/off the IR LED manually. 

 Turn on: Turn on LED 
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 Turn off: Turn off LED 

 Low lux mode: The video quality will be improved when the camera is in 

low lux environment. 

 Disable dark mode: Disable low lux mode. 
 Enable dark mode: Enable low lux mode. 

 

Audio Setting 

 

 Mute: Audio mute. 

 Microphone: Internal / External microphone. 

 Mic Volume: Adjust microphone volume, which ranges from 1 to 46. 
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Video Record 
 Every day: Enter the Start time and Stop time for day mode.  

Note: The time format is [hh:mm] and is expressed in 24-hour clock time. By 

default, the start and end time of day mode are set to 01:00:00 and 

23:59:59. 

 Week day: SUN, MON, TUE, WED, THU, FRI, SAT, select the days of the 

week to perform the application and set the start and the end time.  

 Selected day: select start and end day, and then select start and end 

time. 

 Record parameters 

 Source: Select a stream for the recording source. 

 Recording interval: Select the recording time interval. 

 Prefix file name: You can setting the file name, and enable or 

disable to add the date and time on file name. 

 Enable cyclic recording: The cyclic recording function is enabled, 

during the transaction stage when a storage space is full and the 

incoming streaming data is about to overwrite the previously saved 

videos. 

 Response mode There are three choices of server types available: NAS, 

SD Card, and USB storage (for CAM5330SZ only). Select the item to 

display the detailed configuration options. 

 NAS 

 NAS server address: Enter IP address of the NAS server. 

 NAS shared directory: Enter the NAS shared directory path. 

 Workgroup: Enter the NAS workgroup parameter. 

 User account: Enter the login name of the NAS account. 

 User password: Enter the password of the NAS account. 

 

Note: Video record with the Application must be set to the same 

shared directory path. If you would like do detail recording settings or 

multi-channel recording, please install bundled 64CH recording 

software in CD. 
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Stream 
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Audio codec setting 

 

 AMR 

The bit rates are selectable at the following rates: 4.75 Kbps, 5.15 Kbps, 

5.9 Kbps, 6.7 Kbps, 7.4 Kbps,7.95 Kbps,10.2 Kbps and 12.2 Kbps. 

 AAC 

The bit rates are selectable at the following rates: 8 Kbps, 16 Kbps, 24 

Kbps, and 32 Kbps. 

 G.711 

 pcmu  

 pcma. 
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Video codec setting 

 

 Select Stream 

 Select Codec Type: The Network Camera supports three kind of video 

compression mode: “H.264” or “MPEG4” or “MJPEG”. User can choose 

one of these compression modes based on requirement or application. 

 Select Video Size 

 Select Connection Type: Intranet or Internet mode  
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 Adjust the Frame Rate: This limits the maximal refresh frame rate per 

second. Set the frame rate higher for a smoother video quality. 

 Select the Intra Frame Period: Determine how often to plant a frame. 

The shorter the duration, the more likely you will get a better video 

quality, but at the cost of higher network bandwidth consumption. 

 Select the Video Quality Type: The balance between the bandwidth 

utilization and video quality.  

 Constant bit rate: Users can adjust the video quality from 20 Kbps to 
12 Mbps. The camera will maintain a constant bit rate output, 
regardless of video quality.  

 Quality: The quality is selectable from 1 to 20. 
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Snapshot and time display setting 

 

Adjust the photo size and to add time and date on the video / photo. 
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Camera Control 

 

Camera control 

The pan and tilt functions can be controlled with these buttons. The “Left” 

button controls the camera to the left; the “Right”, “Up”, and “Down” 

buttons control the camera accordingly. 
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 UL, UR, LL and LR buttons control the camera to an oblique angle. 

Home button controls the camera to the center. 

 Zoom: Zooms in and out of the video image. (For CAM5330SZ only) 

 Focus: Set focus of the video image. (For CAM5330SZ only) 

 Iris: Set Iris of the video image. (For CAM5330SZ only) 

 Pan speed: This sets the speed of the horizontal movement of the 

camera. 

 Tilt speed: This sets the speed of the vertical movement of the camera.  

 Zoom Step: Zoom step can be adjusted to bigger or smaller steps. 

 Focus Step: Focus step can be adjusted to bigger or smaller steps. 

 Patrol Cycle: It is the cycle of patrol function. 

 Auto Pan Speed: This defines the speed of auto panning. 

 Auto Patrol Speed: This defines the speed of auto patrol.  

 

Preset point setting 

 

 Set the home position 

 Set default value as home position: Restore home position to original 

default’s home by clicking on this button. 

 Set the current position as home position: Click on the button will set 

the current aimed position as home of the Network Camera. Each time 

the Network Camera reboots or finishes calibration, it will automatically 

aim to the defined home position 

 Set the auto pan range 
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 Set default value as auto pan range: Restore auto pan range to the 

default by clicking on this button. 

 Set the auto pan range manually: Click on the button to set the auto 

pan range. 

 Add or delete a preset point 

 Add current point as a preset point: If users want to save the current 

view as a preset location, enter a name to each of the current video view 

on “Preset points” and click on the “Finish” button. The camera allows 

20 preset locations to be saved. 

 Delete a preset point from below” This keeps a list for preset positions. 

Clicking on the “Finish” button will remove the current selected position 

from the preset list. 

 

Patrol list setting 

Once the presets are set, the patrol setting will show up. 

 

 Preset points: The camera has 64 preset points. Drag the preset points 

you have set on the left to the patrol list on the right.  
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 Patrol list: Users can drag the preset point to arrange the order and set  

 Dwelling time (sec): the stop time of each preset location during auto  

 patrols. 

 Remove patrol point: Drag the unwanted preset points from the patrol 

 list to the Remove patrol point bin . 
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Application 

 

 Schedule mode 

 Every day Enable/Disable every day application.  

 Week day Enable/Disable week day application. 

 Selected day Enable/Disable selected day application. 

 

 Schedule information 

 Enter the Start time and Stop time for day mode.  

Note: The time format is [hh:mm:ss] and is expressed in 24-hour clock time. 

By default, the start and end time of day mode are set to 00:00:00 and 

23:59:59. 

 

 Week day: SUN, MON, TUE, WED, THU, FRI, SAT, select the days of 

the week to perform the application and set the start and the end 

time.  

 Selected day: select start and end day, and then select start and 

end time. 

 

 Trigger mode 

 Video motion detection: Enable/Disable video motion application. 

Click New to add new windows; up to 16 windows can be created. 
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Drag the created windows to the desired location. Use the object 

size and the sensitivity bars to adjust the parameters.  

 Periodically: This option allows the Network Camera to trigger 

periodically for every other defined minute. Up to 999 seconds are 

allowed. 

 Digital input (For CAM5330SZ only): This option allows the Network 

Camera to use an external digital input device or sensor as a trigger 

source. Depending on your application, there are many choices of 

digital input devices on the market which helps to detect changes 

in temperature, vibration, sound, and light, etc. 

 Video Tracking: Use this option to track dynamic objects within 

screen video. Tracking level can be set from 1 to 5, the lower the 

level, the more sensitive. 

 

 Media mode 

 System log 

 Snapshot 

 Record 

 Message 

 Generate digital output signal 

 

 Response mode 

 Send a Email 

 Email security mode: SMTP, TLS, SSL 

 Server address: Enter the domain name or IP address of the 

server. 

 Server port: The default mail server port is set to 25. You can 

also manually set another port. 

 User account: Enter the login name of the email account. 

 User password: Enter the password of the email account. 

 Sender email address 

 Recipient email address 

 Email subject 
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 Email body 

 

 Upload to FTP server 

 FTP server address: Enter the domain name or IP address of the 

FTP server. 

 FTP server port: By default, the FTP server port is set to 21. 

 User account: Enter the login name of the FTP account. 

 User password: Enter the password of the FTP account. 

 FTP folder name: Enter the folder where the media file will be 

placed. If the folder name does not exist, the Network Camera 

will create one on the FTP server. 

 

 Upload to HTTP server 

 URL: Enter the URL of the HTTP server. 

 User account: Enter the username if necessary. 

 User password: Enter the password if necessary. 

 

 Store at NAS 

 NAS server address: Enter the IP address of the NAS server. 

 NAS shared directory: Enter the NAS shared directory path. 

 Workgroup: Enter the NAS workgroup parameter. 

 User account: Enter the login name of the NAS account. 

 User password: Enter the password of the NAS account.  

 

Note: Video record with the Application must be set to the same shared 

directory path. If you wish to set recording setting details or multi-

channel recording, please install 64CH recording bundled software from 

the CD. 

 

 Store at SD card 

 Store at USB flash disk  (For CAM5330SZ only) 
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Storage 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. SD Card / USB Flash Drive (For CAM5330SZ only) contents information 

2. Device contents in details 

1 

2 

3 
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3. Right-click on the blank area to see options of upload, format and quit. Files 

can be managed here. Move the mouse to the file and right-click to see the 

options to delete, format, or quit.  

 

Note：Allow users to upload or delete files when the storage device is not 

write- protected. If the SD card can’t be detected, please link to the 

following URL: http://www.sdcard.org/consumers/formatter to 

download the “SD Formatter Kit” to format your SD card. 

 

NAS server setting 

 

 NAS Host name: Input the NAS Host name of this camera. 

 Workgroup: Input the name of Workgroup. You can see the NAS Host 

name you input in the same workgroup with your PC. Then you can 

connect to this device and download the files easily from SD card or USB  

(For CAM5330SZ only) which is inserted to this camera. 

 

 

http://www.sdcard.org/consumers/formatter
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Syslog 

 

The log lists important information such as login information, changes to 

camera settings (both successful and unsuccessful), triggered events, and 

error messages. This information can be very useful in the event of a camera 

failure or unauthorized entry. 

 

The protocol is compliant to RFC 3164. If you have external Linux server with sys 

log service, use “-r” option to turn on the facility for receiving log from remote 

machine. Or you can use some software on Windows that is compliant to RFC 

3164. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog.com/kiwi-

syslog-daemon-overview/. 

Check Setup and Enable then input the IP address and port number of the 

log server to enable the remote log facility. 

http://www.kiwisyslog.com/kiwi-syslog-daemon-overview/
http://www.kiwisyslog.com/kiwi-syslog-daemon-overview/
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Status and Parameters 
Find the system information such as “Upnp port forwarding”, “Traversing 

NAT”, “Public IP”, and so on. Users also can see the number of current viewer 

of the Network Camera here. 
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Maintenance 

 

 Reboot system: The Reboot button will reboot the Network Camera. It’s 

useful while the Network Camera got problem. 

 Restore system: Click the Restore button to restore to the factory 

default settings except settings in Network type and Root Password 

when these 2 options are not checked. When these 2 options are 

checked, the system will restart and require setting up the network 

again. 

 Calibrate camera (For CAM5330SZ only) 

• Recalibrate the home position to the default center. Once clicking 

the Calibrate button, the Network Camera will calibrate 

immediately. 

• Recalibrate the autofocus position. Once clicking the Calibrate 

button, the Network Camera will calibrate immediately. 

 Export/Import file 

 Export setting backup file: Click Export to export all the 

parameters and user-defined scripts for the device. 
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 Import setting backup file: Click Browse… to upload a setting 

backup file.  

 

Note：The model and firmware version of the device should be the same for 

the setting backup file. If you have set up a fixed IP or other special 

settings for your device, it is not suggested to upload a settings backup 

file. 

 

 Upgrade firmware: Select the firmware file and click upgrade button. 

Please do not turn off the power during upgrading and wait till the 

process completes.  

 

Warning: The upgrade firmware procedure cannot be interrupted. If 

the power and/or network connection are broken during the procedure, it 

might possibly cause serious damage to the Network Camera. 

 

Note: Firmware upgrade will take 120~210 seconds, the system will restart and 

require the installer to set up the network again.    
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Chapter 5. Configuration  

through the IP Utility  
Camera configurations can be done through web interface and IP Utility.  

**For IP Utility, please look into this chapter; for web interface, please refer 

to Chapter 4.  

  Web Interface IP Utility 

General Basic Settings V X 

User Account V X 

Date & Time V X 

Network Network Configuration V Set IP Only 

Port Settings V X 

UpnP V X 

Wifi Setting V X 

Video & Audio Settings Basic Settings V X 

Image Appearance Settings V X 

Video Streams V X 

Audio Settings V X 

PTZ RS-485 Settings/PTZ Settings V X 

Recording Recording Basic Settings V X 

Recorded File Management V X 

Event Notification Event Server V X 

Motion Detection V X 

Tampering Detection V X 

DI & DO V X 

Event Settings V X 

System MicroSD Card Management V X 

System Status V V 

System Log V X 

Firmware Upgrade V V 

Resetting to Factory Default Settings V X 
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 Export/Import V V 

 Reboot V V 

Camera Search  X V 

Login  V V 

Properties  X V 

Delete from Tool  X V 

Clearing and Setting Status  X V 

Camera Group Actions  X V 

Focus Tool  X V 
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5.1. Overview 
The IP Utility is a set of tools for network cameras. It includes tools to create, 

modify, delete and manage groups within the camera; The IP Camera Utility 

also provides tools to perform simple connectivity configuration, firmware 

upgrades and reboot operations. The utility is intended to simplify the 

configuration and management of multiple cameras.  
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5.2. Installing the IP Utility 
Install the IP Utility with the following steps: 

1. Start SearchToolInstall.exe to begin the utility installation dialog:   
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2. Click Next to continue with installation.  

 

3. Fill in the Folder field to specify the installation path. Clicking 

Browse… pulls up a file system browser. Clicking Disk Cost will 

display free space and the space the utility will take up on disks. 

4. Choose if you wish to install the application for the current user only 

(Just me) or all users on this computer (Everyone). 

5. Click Next to continue. The system will respond with a ready screen. 

Click Next again. The system will respond by displaying installation 

progress. 

6. You may click Cancel at any time before finishing introduction, or 

<Back if it is available to cancel or jump back a step. Click Close 

when after installation is complete. The software is ready to use at 

this point.



 

 86 

5.3. IP Utility Basics 
Starting the IP Utility 
To start the IP Utility, double-click the IP Utility shortcut on your desktop or 

go to Start > Program Files > IP Utility> IP Utility.  

Note: On startup, the utility will automatically scan for IP Cameras on the 

same subnet as the computer. In some cases this may result in longer wait 

times. 

 
IP Utility Main Screen 
The IP Utility main screen is divided into 3 sections: 

 

1. Camera Group Display – displays group details 

2. Camera Detail Display – displays camera details 

3. Function Buttons and Menus – this section contains alternative 

access methods for functions that can be done within the Camera 

Group and Camera Detail Displays. This manual does not discuss this 

section separately. 
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Exiting the IP Utility 
To exit the IP utility, click the X button on the top right corner of the screen 

or choose File > Exit from the menu bar. 
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5.4. Camera Actions 
This section displays camera information, including the IP, Name, Model, MAC 

Address, Status and Network Mask. 

 
Search 
Search updates the details for the cameras listed, as well as locates any new 

cameras connected on the same subnet. The search is performed every time 

the IP utility starts. To perform search again:  

1. Click the Auto Search button or click Camera > Search in the menus. 

The search will begin, and a status bar will display the search 

progress. 

 

Note: The search may take up to 2 minutes, depending on your network  

configuration. 
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Login 
Before performing camera actions, most cameras require that proper login 

credentials are supplied. To login to a camera:  

1. Right click the camera you wish to set. Select Login from the popup, the 

system responds with the Login window. Alternatively, click the camera 

entry and choose Login from the Camera menu.  
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2. Fill in the user name and password. 

   

3. Click OK to set the username and password. 

Note: To perform further configuration, please make sure that the User set 

here has administrator privileges. The default Username/Password for cameras 

is admin/admin. 

 
Properties 
The properties of a camera can be viewed by following these steps: 

1. Select a camera by checking the box in the first column of its listing. 

2. Right click the camera and select Properties, or select Camera > 

Properties from the menu bar.  
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The Camera Information popup will display with camera details. 
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Delete from Tool 
1. Select one or more cameras by checking the box in the first column of 

their listing. 

2. Right click the camera(s) which you want to delete from the tool and 

select Delete from Tool. The camera will be removed from the listings. 

 

 
Select All  
In a group context, right clicking a camera, and selecting Select All will 

select all the cameras in the group. 
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Rebooting Camera 
In certain cases it may be necessary to reboot the camera. To do this: 

1. Select a camera by checking the box in the first column of its listing. 

2. Click the Reboot button or select Camera > Configuration > Reboot 

from the menu bar.  

 

 

The camera will reboot. If further configuration is needed, perform 

the Login function again after the reboot is completed. 
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Set IP  
The IP Address of a camera can be set by following these steps: 

1. Click the Set IP button. 

     

 

2. You can choose to obtain an IP address from DHCP or assign a fixed IP. 

 

3. Select one or more cameras by checking the box in the first column 

of their listing. Click Select All.  

4. A Login window will pop up. Fill in the user name and password. Click 

OK. 
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Click OK to save or Cancel to abort the changes before you leave the page. 

 
Link to Camera Web Interface 
Link to Camera 

1. Select a camera by checking the box in the first column of its listing. 

2. Double click the selected camera or select Camera > Link to 

Camera in the menu bar. The camera’s live view webpage will open 

in a browser window. 
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Link to Camera User Manager 

This function links to the user management page of the selected camera. 

1. Select a camera by checking the box in the first column of its listing. 

2. Right click the camera and select User Manager or click Camera > User 

Manager in the menu bar. The camera’s user management webpage will 

open in a browser window.  
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5.5. Camera Group Actions 
The Camera Group frame contains a simple tree containing group listings. 

There are two pre-defined subsections. 

 All Devices - contains all the cameras in the tool, as well as 

predefined groups New Devices and Warnings/Errors 

 MyGroup – contains only user defined groups. 

 
Add Group 
1. Right click the MyGroup root, and choose Add Group or choose Add 

Group from the Group menu. 
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The system responds with the Add Group popup.  

2. In the New Group Name field, type in a group name.  

         
3. Click OK to add the group. The group will appear under MyGroup 

Note: Camera group names can contain upper and lower-case letters, 

numerals and the _ symbol. Cameras can belong to more than one group. 

 
Delete Group 

1. Expand MyGroup and right-click the group you wish to delete. 

2. Choose Delete Group to delete the group. Alternatively, click the group 

and choose Delete Group from the Group menu. 
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3. The system will ask to confirm the deletion. Click Yes to delete the 

group. 

Note: Groups may be deleted, even if they contain cameras. 

 
Rename Group 
1. Expand MyGroup and right-click the group you wish to rename. 

2. Choose Rename Group. Alternatively, click the group and choose 

Rename Group from the Group menu. 
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The Rename Group popup appears.  

 

3. Enter a new group name in the New Group Name field.  

 

4. Click OK to save your changes. 

Note: Camera group names can contain upper and lower-case letters, 

numerals and the _ symbol.  

 
Move to Group 
This function moves the selected camera(s) from a group to another group. 

1. From the Camera Group window select a group under MyGroup. 

2. Select one or more cameras from the existing group by checking the box 

in the first column of their listing. 

3. Right click the camera and select Device Group > Move to Group, or 

select Camera > Device Group > Move to Group from the menu bar. 
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4. In the Select Group pop-up box select the destination group. 
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5. Click OK to move the selected camera(s) to the group.  

Note: Cameras can not be moved from groups under All Devices. 

 
Copy to Group 
 This function copies the selected camera(s) from a group to another group. 

1. From the Device Group window select a group. 

2. Select one or more cameras from the existing group by checking the box 

in the first column of their listing. 

3. Right-click the camera(s) and select Device Group > Copy to Group, or 

select Camera > Device Group > Copy to Group from the menu bar. 
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4. In the Select Group pop-up box select the destination group. 

 

5. Click OK to copy the selected camera(s) to the group.  



 

 104 

5.6. Configuration Settings 
Configuration can be downloaded and updated by selecting Camera > 

Configuration, or the process can be automated by downloading the 

configuration from one camera using the Download Configuration function, 

and then using the Update Configuration function to upload the changed 

configuration file.  
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Download Configuration 
This function downloads a configuration file. 

1. Select a camera by checking the box in the first column of its listing. 

2. Right-click the camera which you want to download from and select 

Configuration > Download Configuration, or select Camera > 

Configuration > Download Configuration from the menu bar. The 

Download Configuration popup will display.  

          

3. Click the Browse button to browse the computer and locate a 

destination. 

4. Click Download to download the configuration file to the destination. 

 
Update Configuration 
1. Select one or more cameras by checking the box in the first column of 

their listing. 

2. Right-click the camera(s) which you want to update to and select 

Configuration > Update Configuration, or select Camera > 

Configuration > Update Configuration from the menu bar. The Update 

Configuration popup will display.  

        

3. Click the Browse button to browse the computer and locate a 

configuration file. 

4. Click Update to upload the configuration file to the camera(s). 
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5.7. Firmware Actions 
Update Firmware 
Once a new version of the camera firmware is obtained, the firmware can be 

updated using the following steps:  

 

 

Note: You must be logged into the camera to update the camera firmware. 



  

  107 
 

1. Select one or more cameras by checking the box in the first column of 

their listing. 

2. Click the Update Firmware button; right-click the camera(s) which you 

want to update to and select Maintenance > Update Firmware; or 

select Camera > Maintenance > Update Firmware from the menu bar. 

The Update Firmware popup will display.  

       

3. Click the Browse button to browse the file system and locate a firmware 

file. 

4. Click Update to upload the firmware to the camera(s). 
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5.8. Focus Tool 
The Focus Tool is used as a reference for focus precision. Click the Focus 

Tool button to open it. 

 

Information of Best Focus Value, Current Focus Value and Focus Percent will 

be shown at the bottom of the Focus Tool Window. You can click Refresh to 

get a new data after focus adjustment is done. 

 

Note: When the Focus Percent is higher, the focus is more precise.  
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